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Using Microsoft Word 
 

Styles and Contents 
Styles enable a user of Word to create ‘sets’ of formatting that can be used 

repeatedly throughout a document. For instance, if you wanted to make sure all 

of the headings in your document appeared the same way, you could create a style 

with all the necessary formatting and apply that style to each of your headings, which would be a 

lot quicker than individually formatting each one. Additionally, once a style has been used in a 

document, changing the formatting for that style will change any parts of the document that use 

that style. This makes it possible to modify the formatting of several sections all at once. In short, 

when you use a style, you can use several formats in one simple step. 

You can create: 

• A character style – to control formats on text within a paragraph such as fonts, sizes and 

colours. 

• A paragraph style – to control paragraph formats such as alignment, tabs and spacing. 

They can also include character formats. 

• A table style – to provide consistent borders, spacing, shading and fonts in tables. 

• A list style – to quickly format numbering or bullet characteristics for lists. 

 

Using styles in a document not only simplifies formatting and helps to keep formatting consistent 

within a document, it can also be used to assist in the generation of special Word objects such as 

document Indexes and Tables of Contents. 

 

 

Now this 

is style 
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Using Built In Styles 

When a new document is created in Word, it will have a few styles included by default. Standard 

text uses a style called Normal. It formats text with Calibri font with 11 point size some extra 

space between paragraphs and lines. Like any style, the Normal style can be modified. A new 

document will also include some default styles for use as headings. These styles can be selected 

in a number of ways as shown in the following exercise.  

Exercise 1. Applying Standard Styles 

1) Open the Word document called Cottage Pie Recipes. All of the text in the document is 

currently formatted using the Normal style. You can tell since no matter where you are in the 

document, the styles selection in the ribbon will show the name of the style for the text your 

insertion point is currently in. 

 
 

2) Click anywhere in the line at the top which says Cottage Pie Recipes. 

3) Move your mouse over the styles shown. Notice that the 

name of each style is shown using a sample of the style’s 

formatting. If you leave your mouse over one of the 

styles, your selected paragraph will change to show you 

how it would look with that style. 

4) Click on Heading 1 to apply that built in style. Because it is a paragraph style, the whole line 

will be formatted without the need to select the whole line. 

Some of the built-in styles may also be selected using certain keyboard shortcuts. 

5) Click on the next line where it says Cottage Pie recipe from British Food. We will format this 

using the Heading 2 style. 

When you have normal text selected (I.e. when you are not in a list) you can use keyboard 

shortcuts to change the selected paragraph to one of the built-in heading styles. The [Alt] [Shift] [] 

shortcut will change to the next heading style while the [Alt] [Shift] [] shortcut will change to the 

previous heading style as you will soon see. 

6) Hold down [Alt] and [Shift] and then press the left arrow key []. The paragraph will now be 

formatted using the Heading 1 style. We want this paragraph to be formatted using the next 

available style which is Heading 2. 

7) Hold down [Alt] and [Shift] and then press the right arrow key []. The paragraph will now use 

the Heading 2 style. Heading 2 should be displayed in the Styles box on the toolbar. 

 
Note When you are in a list, these same shortcuts may be used to adjust indentation and 

promote/demote list items.  

 
Tip With normal text selected, the [Alt] [Shift] [] shortcut will apply the heading style last used. The 

[Alt] [Shift] [] will apply the Heading level below the one last used. 
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Using the Styles and Formatting Task Pane 

One easy way to work with styles is to display the Styles Pane on the 

side of the window. 

You can easily display the styles task pane by clicking the small Styles 

icon in the corner of the Home ribbon group.  

Exercise 2. Applying Styles 

1) Click in the paragraph which contains the single word Source.  

2) Click the Styles icon in the corner of the Home ribbon group . 

The task pane should appear as shown to the right. With the task 

pane visible you can see a complete list of styles that are being 

used in a document and select styles from the list by clicking on 

them. The task pane also makes several other useful options 

available as shown later. 

3) Click on the Heading 2 style in the list to apply that style to the 

selected text and then use the [Alt] [Shift] [] shortcut to change it 

to a level 3 heading (which will now appear in the styles list. 

4) Click in the line which says Ingredients and click the Heading 3 

style to apply it. Do the same for the line which says Method. 

5) Time to practice. Continue through the rest of the document and use any of the methods you 

have tried so far to format the remaining headings. All of the recipe names (E.g. Comforting 

cottage pie and Proper English Cottage Pie) should be formatted using the Heading 2 style. 

All of the headings which say Source, Ingredients and Method should be formatted using the 

Heading 3 style. 

6) Save the changes to the document when all the headings have been appropriately formatted. 

As in the example below. 

 

 
 
Note Applying a style may replace existing formatting. 
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Modifying Styles 

When you change a style’s attributes, any part of your document which that style has been applied 

to will update to take on the changed attributes of the style. Styles can be changed by editing the 

options for a style. They can also be changed by formatting a section of your document the way 

you want the style to look, selecting it and then changing the style to match what is selected. 

Exercise 3. Updating Style Definitions 

1) Make sure the Styles task pane is showing on the side of 

your screen. 

2) Move your mouse over the Heading 1 style and 

click on the drop-down arrow which appears. A 

style menu will be displayed.  

Note the first option displays the number of instances 

where the style is used and allows you to select each 

instance of that style. In this case, selecting this option 

would select every paragraph where the Heading 1 

style is used, though only one paragraph is currently 

using it. You will also notice that the delete option is unavailable since Heading 1 is one of the 

standard styles. You can only delete new styles that you have created. Deleting a style will mean 

that any text using that style reverts to using the Normal style. 

3) From the style menu click the Modify option. The following dialog will appear. 
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4) Change the font size from 16 to 22 and change the alignment to centre. The options should 

look the same as the example above. 

5) Click OK to update the style definition. The first paragraph, which uses the Heading 1 style 

will update to reflect the formatting changes. If other paragraphs used the same style then they 

would also update. 
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Exercise 4. Updating Styles by Example 

1) Select the first paragraph that uses the Heading 2 style (Cottage Pie recipe from British Food). 

2) Change the formatting of the paragraph so that it is a different colour, size sixteen and remove 

the italic formatting. 

If you look in the Styles and Formatting task bar, you will notice that 

the Heading 2 style is listed twice. The first one is for the style on its 

own. The second one is for instances of the style where additional 

formatting has been applied.  

3) Click on the arrow next to the main Heading 2 style (the one without the modifications). 

4) From the style menu which appears, select Update 

Heading 2 to Match Selection. 

The Heading 2 style will be changed to match the 

selected text. The modified version of the style will 

also disappear since that has now become the main 

style. 

5) Scroll through the document to check that the rest of the headings using the Heading 2 style 

have been updated with the formatting changes. 

Creating Styles 

Like most tasks in Word, there is more than one way to create a new style. The following exercises 

will demonstrate some of those methods. Note that styles you create can also be deleted, but built 

in styles such as Heading 1 cannot be deleted. 

Exercise 5. Creating a New Paragraph Style 

1) Select the source for the first recipe. Your selected text should contain a web address. 

2) Change the formatting to Arial, 10pt font size, 0.5cm indent and underlined. The text should 

look like the example below. 

 

 
 

3) Make sure the text you just formatted is still selected. Because we are going to create a 

paragraph style it is not necessary to select the entire paragraph style. Selecting any part of the 

paragraph or even just having your insertion point somewhere within the paragraph is 

sufficient. 

The style box on the ribbon will show the name of the currently selected 

style. Currently you have selected text which is using the Normal style 

in addition to some modifications.  
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4) Click the icon  at the end of the styles section of the Ribbon. 

5) From the menu which appears, select . 

6) When the Create New Style from Formatting dialog appears, enter 

Sources for the style name and click OK. 

 

Notice that the new style will now appear in the Styles pane. The icons 

next to each style show you what type of style it is. For example your 

new Sources style has a  icon which tells you it’s a style which 

contains both paragraph and character formatting. 



Using Microsoft Word 2016  11 - Styles and Contents 

 

© Steve O’Neil 2017 Page 8 of 22 http://www.oneil.com.au/pc/ 

 

7) Use the methods you have learned previously to apply the sources style to all the other website 

addresses in the document. Since it’s a style with paragraph formatting, you won’t need to 

select a whole paragraph to apply the style. 
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Exercise 6. Creating a New Character Style 

The styles box provides a quick way to create paragraph styles, but for other types of styles and 

additional options, you can use the New Style dialog. We’re going to create a new paragraph style 

that we will use to format key phrases in the recipes. 

1) Click the New Style button at the bottom of the Styles and Formatting task pane. 

 

A dialog box like the one shown below will appear.  

 
The options are explained below. 

Name Name of the new style 
Style Type Choose from paragraph, character, list etc. 
Style based on You can choose to use an existing style as the starting point for a new 

style. If the original style is changed, any similar formatting in the new, 

related style will also change. This option is not available if list style is 

selected in style type. 
Style for following 
paragraph 

You can specify a default style to follow the current style. For example, 

if you are editing the Heading 1 style, you can use this to specify that 

when a user presses [Enter], the next style will automatically be set to 

Heading 2. This option only applies when the style type is set to 

paragraph. 
Formatting These options will vary depending on the style type selected and provide 

quick access to formatting options. 
Format The format button provides access to advanced options such as the Font 

formatting dialog and the Paragraph formatting dialog. 
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2) For the style name enter Keywords. 

3) Change the style type to Character. 

4) We could use the few options available for specifying the format for 

the style but we need more options so click the Format button. Only 

the options that relate to Character styles are displayed. Click Font 

to display the Font formatting dialog. 

5) Change the font formatting options so that they are similar to the 

ones shown below. 

 

 

 

 

 
 

6) Click OK to after the options are all set. 

Changed 

font and 

font 

colour 
11pt font size 

Double underline 

changed underline colour 

Shadow effect 
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7) Check that the style options look like the ones below and click OK to create the style. 

 

 
 

8) In the method section for the first recipe select the word Peel. 

9) Apply the new Keywords style to that text 

10) Continue through the document and apply the style to other words that may be key parts of 

the recipe such as chop, fry and mix. 
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Exercise 7. Creating a List Style 

1) Click the new style button.  

2) Change the options as shown below. 

 

 

3) Click on the Insert Symbol icon . A dialog box like the one below will appear. 

 

Ingredients for the 

style name 

List for the style 

type Click the bullets icon to 

make it a bulleted list 
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4) From the list at the top choose a symbols font such as Wingdings or Webdings and then select 

a suitable symbol to use for your bullets. 

5) Alternatively, you could click the Insert Picture icon  and then select a picture to use as a 

bullet symbol. 

6) When you are satisfied with your selection, click OK to complete the creation of the style. 

7) Select the ingredients for the first recipe and apply the new Ingredients style. 

 
Note If the style doesn’t appear in your main list of styles, click the Multilevel List icon 

 in your ribbon. You will be able to select the new list style from the menu 
which appears. 

 

 

 

8) Apply the style to the ingredients in the other recipes. 
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Exercise 8. Style Sets 

Word contains several sets of styles which are intended to work together to give your document 

a consistent look. These style sets contain styles for common document elements such as headings. 

1) Scroll to the top of your document where you can see the main different types of headings in 

use. 

2) Click the Design tab on the ribbon. 

 

A range of style sets will appear on the ribbon. 

 

3) Move your mouse over some of the available style sets. As you move your mouse over each 

one, the styles in your document (such as heading styles and the normal style) will change to 

show how they would look using that style set. 

4) Select a style set that you like the look of and click on it to apply the set.  

 

 
 

 

 Additional style sets are available if you choose a different theme. 

 

The themes button might not be available if your file has been opened in compatibility mode. This 

is because the cottage pies document was created in an older version of Word so newer features 

might be disabled. You can tell this is the case if you see Compatibility Mode next to the filename 

at the top.  

To fix this problem simply select File and Save As or press [Ctrl] [F12] and when you save the new 

copy of the file, make sure the format is set to Word Document instead of Word 97-2003. 



Using Microsoft Word 2016  11 - Styles and Contents 

 

© Steve O’Neil 2017 Page 15 of 22 http://www.oneil.com.au/pc/ 

 

  

Exercise 9. Additional Practice 

1) Click the arrow next to the Heading 2 style and select 

Modify. 

 

 

 

2) Click the Format button at the bottom of the styles 

options and select Paragraph.  

 

 

3) When the paragraph formatting options appear, click the Line and 

Page Breaks tab at the top.  

 

4) Click the Page break before option.  

5) Click OK to close the Paragraph formatting options.  

6) Click OK again to close the style options and confirm the change. Each paragraph using the 

Heading 2 style will now begin on a new page. Don’t worry about all of that blank space on 

the first page. We’re about to make use of that. 
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Tables of Contents and References 

One of the most useful things about using heading styles in a document is that they can be used 

to automatically create an index or a table of contents. These will use your style to create fields 

complete with links and page numbers, which can be automatically updated when the document 

changes. 

Exercise 10. Creating a table of contents 

1) Click on the blank line beneath the main heading on the first page. This is where our table of 

contents will be placed.  

2) Select the References tab on the Ribbon. 

3) Click the Table of Contents icon on the left end of the ribbon. 

 

A menu will appear showing a couple of Table 

of Contents styles. 

 

 

 

4) Select the  option from the bottom of the menu. 

The Index and Tables dialog will appear. 



Using Microsoft Word 2016  11 - Styles and Contents 

 

© Steve O’Neil 2017 Page 17 of 22 http://www.oneil.com.au/pc/ 

 

 

 

5) View the different Formats options and see the result in 

the Print Preview box. Select a format that you like the 

look of.  

6) Click the Options button. 
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These options allow you to specify which styles will be included in the table of contents and what 

level they will be. The first three headings are selected by default. You can add additional 

paragraph styles to be included but we’ll leave them as they are for now. 

7) Click Cancel to return to the main Index and Tables options. 

8) Click OK to complete the table of contents. 

A table of contents is automatically generated from the paragraphs in your document that are using 

the heading styles. 

 
 

The table of contents is a field, just like page numbers in footers or totals in a table. This means 

that it can update when there are changes to the document information that it is based on. If you 

make changes to your document and want to update the table to reflect the changes, you can 

update the field. 

9) Right-click inside the table and select Update Field (or click inside the field and press the [F9] 

key which does the same thing). The following options will appear. 

 

 
 

10) The first option will only update the page numbers without changing any of the items in the 

table of contents. The second option updates page numbers and will also check the document 

for additional headings to add to the table of contents and deleted headings to remove from 

the table of contents. 
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Note When you have a table of contents or an index referring to page numbers, it makes sense to add 

page numbers to each page using headers and footers as shown earlier. In this exercises we 
haven’t done that but if you can’t remember how, refer back to the earlier exercise titled Paragraph 
Formatting. 

 
Tip If you move your mouse over the table you will see a message like the 

one to the right. Holding down [Ctrl] and clicking on an item in the 
contents will take you to the part of the document that the item refers to. 

 

 

Exercise 11. Using the Navigation Pane 

When you start Word, the Navigation pane will sometimes be visible on the left side of your 

document. This provides you not only with useful tools for navigating your document. It also 

provides some useful tools for changing the structure of your document. 

1) If you can’t see the Navigation Pane, click the View tab on the Ribbon.  

2) From the Show section of the ribbon, click the Navigation Pane option to 

make sure it is ticked. 

The Navigation Pane should be visible to the left of your document. 

 

The Navigation Pane will show the paragraphs that have been formatted using heading styles. 

3) Click on a heading within the Navigation Pane. You will be taken to that heading. 

You can also use the Navigation Pane to rearrange sections of your document 

4) In the Navigation Pane, move your mouse over Proper English Cottage Pie. 

 

5) Drag that heading so that it is above Comforting Cottage Pie. 
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6) Not only will this change the order of the headings in your document, it will also change the 

order of everything under those headings. It is an easy way to re-arrange entire sections within 

a document. 
Note This would be a good time to update your table of contents since the order of the recipes will have 

changed. 

Exercise 12. Adding Internal References 

There are times when it is useful to have a reference to another page in the document without 

having to create an entire index or table of contents. There are two steps to doing this. The first 

step is to create a bookmark at the location you want to refer to. The second step is to create a 

reference that points to that bookmark. 

1) Scroll to the end of the document and select the last word, which should be grill. 

2) From the Insert tab, click on the Bookmark icon in the Links section.  

3) Under Bookmark name, type grill. 

4) Click the Add button. 

 

5) Click on the Bookmark icon again and you will see that the grill bookmark has now been added. 

We will create a reference elsewhere using this bookmark as target. 

6) Click Cancel to close the Bookmark dialog. 

7) Scroll to the first recipe (Cottage Pie recipe from British Food). 

8) Scroll to the last sentence and add the following text to the end of the paragraph (With 2 spaces 

instead of one between the words page and also). 

 

The Townies Cottage Pie on page  also grills the pie. 

 

9) Format the text in italics. 

10) Place the insertion point between the words page and also. 

11) Select the References tab and click on the  icon. 
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12) Since there is only one bookmark it will already be selected in the list. Click the Insert button 

to place the reference in the page. 

13) Click on Close to close the Cross-reference dialog. 

 

 
 
Note If the page numbers in your document change, you can update the field in the usual way to bring 

the number up to date. 

 

 

 

  

Select Bookmark 

as the Reference 
type 

Select Page number 

under Insert 
reference to 
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Exercise 13. Adding a Footnote 

When a writer wants to support their text with a brief bit of additional information without 

disrupting the flow of the text, a footnote may be used. Footnotes are easy to create in Word. 1 

1) In the ingredients for the first recipe, click at the end of the line which says, A handful of peas 

(can be frozen). 

2) From the References tab, click on the Insert Footnote icon. 

 

A new footnote will be created at the bottom of the page just above the area where the footer 

would be. 

 

3) Type the following text. 

 

Other vegetables may also be added for variety 

 

The footnote reference should now look like the example below. 

 

4) Save and close the document. 

                                                 

 
1 This is an example of a footnote 

 


